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The EasySense program  
 

Select a User level 
The first time VISION is used a ‘Select Program Level’ window will 
automatically open. Select a suitable user level and select OK.  
 

 Level 1 is aimed at ‘start’ level (e.g. up to 9 years old)  

 Level 2 is aimed at ‘mid’ level (e.g. 9 – 15 years old) 

 Level 3 is aimed at ‘exam’ level (e.g.15 years plus)  
 
Note: The program level can be altered by selecting Level from the 
Settings menu.  

  

The Home window 
Home is the main navigation window, which 
contains the icons for all logging options. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
The appearance of the Home screen and the complexity of the toolbars and functions in the experiment 
options are altered by the user level selected.   

 
 

EasyLog 
Select EasyLog and the graph 
window will open pre-set to 
record sensor values 
continuously as a line graph 
until stopped.  
 
See page 8. 
 

 
 

Meters 
The Meters window gives an 
introduction to sensors and how 
they respond to change.  
Up to four section displays can 
be open at any one time and 
they can be any combination of 
sensors and displays. 
 
See page 6. 

Home at Level 2 and 3 

 

 

 

 

 

 

  

Home at Level 1 
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Snapshot 
The Graph window will open pre-
set to record sensor values on 
demand (manual sampling) with 
a bar graph display. 
 

See page 8.  
 

 
 
Graph 
The Graph window is set to 
record sensor values against a 
chosen time span as a line 
graph display. The window 
opens with a real time logging 
wizard from which the time span, 
interval between samples, start 
condition and triggers for the 
recording can be chosen. 
 

See page 9. 
 

Scope 
A simple oscilloscope type 
display. The data from a sensor 
is redrawn continuously on the 
screen. Ideal for demonstrating 
fast events where there are rapid 
changes such as ECG traces, 
sound waveform, etc.  
 
Note: Scope is not available when 

the User level is set to Level 1. 
 

See page 11. 
 

Timing 
Timing is used to allow students 
to study Time, Velocity, 
Acceleration, Momentum and 
Kinetic Energy relationships 
using switch-type (digital) 
sensors such as Light Gates.  
 
See page 12. 

 
 

Open 
Use to load a previously saved data file. Locate the correct EasySense file (.SSL) and 
select OK. See page 43. 

 
Interface 
Use to connect VISION as an interface controlled by the EasySense software on the PC 
computer. See page 47. 

 
Apps  
Use to open or manage other applications available on VISION e.g. the Periodic Table. 
See page 45. 
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The Meters option 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 

When Meters is selected from the Home screen, the window will open with live data being displayed from 
the first sensor it identifies in a Numeric window.  
 

Select the Stop icon  to stop data being recorded.  
 

To begin recording again select the Start icon.  
 

 Up to four section windows can be open at any one time and they can be any combination of sensors 
and displays. 

 

 A section window can be opened either by selecting the appropriate icon on the Toolbar or from the 
drop-down Display menu. 

 

 To alter the sensor displayed in a section, tap and hold      (or right click 
with the mouse) in the section window and a Sensor Selection window 
will open. Select the sensor to display in that section from the list.  

 

 Select the close button  to close a section window. 
 

 A section window can be maximized to fill the whole window by selecting the maximize button,  
select again to return to ¼ screen size.  

 

 Select the Home icon  to return to the Home screen 
 

As soon as you open Meters or click on the Start/Stop icon, the data is recorded ‘behind the 
scenes’. This data can be transferred into the Graph window for display and analysis using the 
Transfer to Graph icon (or select from the Edit menu). When in Graph select the Back to Meters 
icon          to return to the Meters window. 

 

 

Close section window 

Maximise window 

Menu bar 

Toolbar 

Sensor and its 
unit of 
measurement 

Section window  

Home  

Start/Stop Display 
Options  

Changes 

Gauge Dial 

Numeric 

Notes 

Transfer to Graph  

Tap and hold        
(or right click 
mouse) to alter the 
sensor displayed.  
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Changes 

This is the simplest 
of all four sections. It 
displays a block of 
colour that changes 
to reflect the value 
being collected by 
the sensor.  
 
Colour changes happen within the span of a 
sensor’s limits. The minimum and maximum of these limits can be altered in Sensor Settings from the 
Display menu or Options icon. 
 
For example: 
Temperature - begins at light blue (coldest) and then works its way up to become dark red (hottest).  
Light - begins at black (no light), works through greys until it becomes white (full light). 
pH – simulates the colour change of universal indicator.  
Sound and other sensors – begin at dark green (minimum), becomes lighter until works through to bright 
green (maximum).  
 
Note: To alter the sensor displayed, tap & hold       (or right click with a mouse) in the section window and select the 
required sensor from the Sensor Selection window.  
 

Gauge 
This section will display a simple bar 
gauge that increases and decreases 
with the measured value. 

 
The scale on the left-hand side is 
divided into sections to correspond to 
the sensor it is representing. 

 
If Show Min Max from the Display menu is ticked, the maximum and minimum value recorded will be 
displayed on the right-hand axis by two short lines. Use Reset Min Max from Display to reset these values. 
 

Dial 
This section displays a traditional dial whose 
pointer moves to the right as the measured 
value increases and, likewise, moves to the 
left as the value decreases. 
 
The scale around the dial is automatically 
set by the software to correspond to the 
sensor it is representing. 
 
If Show Min Max from the Display menu is ticked, two thin lines will display the maximum and minimum 
value recorded. Use Reset Min Max to reset these values. 
 

Numeric 
This section displays the currently 
measured value as a number.  
 
The maximum and minimum value 
recorded will be displayed if Show Min 
Max from the Display menu is ticked. Use 
Reset Min Max to reset these values. 
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Decimal numbers can be switched off by deselecting Display Decimals in Sensor Settings from the 
Display menu or Options icon. Without decimals selected, the reading will be rounded up to a whole 
number.  

 
Sensors  
The sensors are automatically identified when the Meter option is 
selected. To change sensors while Meters is open, simply replace the 
sensor with a different type. When logging is restarted Meters will 
automatically change the sensor settings so that the correct calibration 
scales are displayed. 
 
To alter the sensor displayed in a section, tap & hold      (or right click 
with a mouse) in the section window and a Sensor Selection window 
will open. Select the sensor to display in that section from the list.  
 
The decimals, name and the minimum and maximum limits of a sensor can be altered either from the 
Display menu or Options icon. See page 26. 
 
To change the range of a sensor e.g. to alter the range of a Heart Rate sensor from Waveform to Beats 
per minute, select Sensor Config from the Settings menu. See page 28. 

 

The EasyLog option 
If EasyLog is selected from the Home screen, the graph window will open pre-set to record 
sensor values continuously as a line graph until stopped. This makes it ideal for 
experiments when the time of the recording is unknown. 
 

Select the Start icon  to begin recording.  
 
Logging will start with a time span of 30 seconds and when it has elapsed the time span will double 
automatically. This will continue until the recording is stopped by selecting the Stop icon.  
 
Choose EasyLog when an X vs. Y graph is required (to plot the readings of one sensor against 
another). Alter the X-axis to display a sensor (rather than time) – see page 25.     

 

The SnapShot option  
If SnapShot is selected from the Home screen, the graph window will open pre-set to 
record sensor values on demand (manual sampling) with a bar graph display. 

 

 Select the Start icon  to begin recording.  
 

 Tap or click in the graph area to collect a sample.  
 

 Select the Stop icon  to stop data being 
recorded.    

 

If you select Start again you will be given the option to 
add new readings to the end of the existing data. If ‘No’ 
is selected the existing data will be deleted. 

 

 

 

 
 

 

Graph area 
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The Graph option 
If Graph is selected from the Home screen, the graph window will open pre-set to record 
sensor values against a chosen time span as a line graph display. The window will open 
with a real time logging wizard from which the time span, interval between samples, start 
condition and triggers for the recording can be chosen. (The options available will depend on 
the level you have selected to work at). When your selection has been made, select Finish. 

The logging wizard  
 

    User Level 1 has a simple two stage logging wizard to set up before capturing data.  

 
Stage 1: Sensor selection 
 

 Deselect the tick next to any sensors from 
which readings are not required.  

 

If sensors have been altered after start 
up, select the Redetect button to identify 
the change of sensor.  

 

 
  
 

To change a sensors range select its name and the set range window will 
open. The range currently selected will be highlighted. Select the required 
range and OK. The sensor range setting will be retained until changed by 
the user. 

 

 
Stage 2: Recording duration 
 

 Select the length of time that you want to record 
from the list. 

 

The interval between each sample and the number 
of samples will automatically alter when the time 
duration is selected.  
 

 Select Finish.  
 

Select the Start icon  to begin recording data.  

 
       User Level 2 and 3 has a three stage recording wizard.  
 
Stage 1: Sensor selection 
 

 Deselect the tick next to any 
sensors from which readings are not 
required.  

 
If sensors have been altered after 
start up, select the Redetect button 
to identify the change of sensor.  

 
 

 
To change a sensors range select its name, the set range window will 
open. The range currently selected will be highlighted. Select the 
required range and OK. The sensor range setting will be retained until 
changed by the user. 

 

Select the 
name to open 
the set sensor 
range window 

 

Select the 
name to open 
the set sensor 
range window 
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Stage 2: Recording duration 
 

 Select the length of time that you want to 
record from the list. 

 

 Select the interval between samples being 
taken. 

 

The number of samples will automatically alter 
when the total recording time and the interval 
between samples are selected.  

 
If a very short recording and intersample time are 
selected then the recording will be in FAST mode. In 
this mode there will be no screen display of the data 
until the recording ends.  
 

Note: If you wish to view fast data as it is being recorded 

then use Scope –see  page 11.  
 

 Select Next. 
 
 
 
 

Stage 3: Select the Start condition as required.  
 

This is used to set the condition required for the 
recording to start.  
 
Pre-triggers will only become available if a FAST 
recording time is selected. 
 

 
                           

 None - To begin recording as soon as you select the Start icon.  
      
 Trigger on Level  - To begin recording when the selected sensor is ‘above’, ‘below’, ‘rises above’ or 

‘falls below’ a set value e.g. when the value from a temperature sensor rises above 15ºC.  
 

 
 
                             
 
     
                                                
 
 
 
 
                                                                

 Select any Pre Trigger requirements.  
 

Note: This option will only become available if a FAST recording time with a trigger on level condition is selected.  
 

Pre-trigger will allow a percentage of samples to be stored before the trigger 
condition is met and the remainder to be taken afterwards. For example, if 1,000 
readings are to be taken and a 25% pre-trigger is selected, 249 readings will be 
taken before the trigger condition is met and 750 on and after the trigger.  
 
Note: Sufficient time must be allowed to elapse for the pre-trigger samples to be taken e.g. 

at a relatively slow sample time of 100 milliseconds with 1,000 samples and a 25% pre-
trigger, it will take 25 seconds to get to the pre-trigger position. 

Above 

For example: - 
To start recording 
when the temperature 
is above 15ºC. 

SET LEVEL 

Below 

For example: - 
To start recording 
when the temperature 
is below 15ºC. 

SET LEVEL 

Rises above                  
For example: - 
Logging will not start 
until the value rises up 
above 15ºC.  

SET LEVEL 

Falls below  

For example: - 
Logging will not start 
until the value falls 
down to below 15ºC.  

 

SET LEVEL 

 

  

Pre-triggers 

 

REAL TIME will 
change to FAST 
recording if a 
combination of 
very short 
recording and 
intersample times 
are selected  
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 Select Finish.  
 

 Select the Start icon . Recording will start when the start condition you have selected is met. The 
recording will stop when the selected time span has passed.  

 

If you want to stop recording before the time span has passed, select the Stop  icon.     
 
If None was the selected trigger then the recording will start as soon as the Start icon is selected.  
 

If recording REAL TIME, with a trigger on level selected, recording will begin when the trigger condition is 
reached.  
 

If recording FAST with a triggered start, a recording data 
message will display (if there is sufficient time!) until the 
trigger condition is met. The data collected will download as 
soon as the recording has finished.  
 
 

The Scope option  
Scope models many of the functions of a simple oscilloscope. It displays ‘real-time’ plots 
(as they occur) from the value of a sensor versus time. Unlike a graph that has a 
beginning and an end, the scope trace is refreshed or ‘redrawn’ continuously as long as 
data is being measured.  

 

Make your selection from the control panel on the right hand section of the Scope window and then 

select the Start icon  to begin recording.  
 

Once data has been recorded, it can be treated in the same manner as normal graph data e.g. the X-
axis altered from time to reading number.  
 

Note: Overlay and Pre-Log functions are not available.  

 

Time base 
Use Faster to decrease and Slower to increase the time period between samples.  
 

Duration 5.12 ms 12.8 ms 25.6 ms 51.2 ms 128 ms 256 ms 512 ms 1.28 s 2.56 s 

Interval 20 s 50 s 100 s 200 s 500 s 1 ms 2 ms 5 ms 10 ms 

Max. no. of sensors 1 2 4 4 4 4 4 4 4 

 

Duration Roll mode Roll mode Roll mode Roll mode Roll mode 

Interval 20 ms 50 ms 100 ms 200 ms 500 ms 

 
When the interval between samples is 20 ms or slower the graph trace will be redrawn continuously – 
roll mode. When you select Stop the trace displayed will ‘freeze’ and the data will become visible in the 
table.  
 

When the interval between readings is 10 ms or faster, scope will be in trigger mode. 
 

Trigger Mode 

 Normal – records a trace for the specified duration each time a specific starting condition (trigger) is 
met. 

 

 Auto - operates in a similar way to Normal, but if after a second the specified start condition is not 
activated, a trace will be recorded. This feature is useful in testing that the trigger settings for an 
experiment are correct. The trace will continue to be updated at a frequency of once per second.  

 

 Single Shot - records one single trace and then stops recording automatically. 

User Level 2 & 3 
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Trigger Edge 

 Positive - the reading from a channel has to rise above a set value to trigger a recording.  

 Negative – the reading from a channel has to fall through a set value to trigger a recording.  
 

Trigger Channel and Level 

 Select the Channel to be used for the trigger condition from the drop-down menu.  

 Tap or click on the Higher or Lower buttons to change the threshold value for the trigger. An 
orange dotted line on the graph will mark the current level. 

 

Pretrigger allows a percentage of samples to be stored before the trigger condition is met and the 
remainder to be taken afterwards.  

 Select the percentage pre-trigger from the pop-up menu (0%, 25%, 50%, 75% and 100%).  

 When logging is stopped a brown dotted line will mark the pre-trigger position on the graph. 
 

 

The Timing option 
The diagram below shows a typical apparatus set up for use with Timing. This option is used 
to handle data from switch-type sensors such as Light Gates and Timing mats which only 
have two states, ON or OFF. 

 
Connect the digital sensors being used to VISION.  
 
Measurements can be taken from either a single sensor 
connected to Input 1:A, or from two sensors connected to 
both Input 1:A and 2:B. 
 
To perform calculations for Speed/Velocity, Acceleration, Distance, Momentum and Kinetic Energy, it is 
necessary to enter the parameters used in an experiment. For example, to calculate speed from A to B, 
enter the distance between the two digital sensors connected to A and B. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In this set up Light Gates are connected to Input A and B on the interface and are used to monitor the 
movement of a cart down a track. An interrupt card is fixed to the top of the cart. The card will cut through 
the Light Gate’s infrared beam. 
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The Timing Wizard 
     User Level 1 has a simple wizard to record Time or Speed at A, Time or Speed from A to B, 

or Time from A to A (stopwatch).  
 

Step 1 Step 2 Step 3 b 

 Time at A Units and decimal places 

 from A to B Units and decimal places 

 
from A to A 
(e.g. Stopwatch) 

Units and decimal places 

    

Step 1 Step 2 Step 3 a Step 3 b 

 Speed 
 
at A 
 

Enter the length of the single interrupt 
card in millimetres 

Units and decimal places 

 
 
from A to B 
 

Enter the distance from the Sensor at A 
to the Sensor at B in metres 

Units and decimal places 

 

 
Step 1: Select whether you want to record Time or Speed/Velocity. Select Next. 
 
Step 2: Select whether you want to measure at A, from A to B or from A to A:  
 

Time Speed 

 at A  at A 

 from A to B  from A to B 

 from A to A (e.g. Stopwatch)  

 
Select Next. 
 

 
Step 3: If a Time option was selected then the next page will be units and decimals – see 3b. If Speed 
was selected, the next page will be for entering the measurement required for the calculation of speed. 
 
 
3a: 
Velocity from A to B - enter 
the distance between the 
sensor connected to Input 
1:A and the sensor at Input 
2:B (in metres).  
 
Tap or click on Next. 
 
 
 
 
 
 
Speed at A - enter the length (l) of the single interrupt card 
that will pass through the sensor connected to Input 1:A (in 
millimetres).  
 
Tap or click on Next.  
 
 
 
 
 

 

 

A
Start - A On Stop - B On

B  

Distance 

 

l 
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3b: Select the number of decimal places and the units for the 
display of calculated data from the drop-down menus. 
 
 
 
 
Select Finish. 
 

Select the Start icon.  
 
When a signal change from the digital sensor/sensors is received, the timing measurement will 
automatically be entered into the table and graph. The vertical axis scale will automatically adjust to 
match the largest value collected. 
 
 

        User Level 2 and 3  

The pages in the Wizard will vary according to the choice made in the previous step.  
 
Step 1: Select how you want to record the data.  
 
Select Next. 
 

 
Step 2: Select whether you 
want to measure at A, at A or 
B, from A to B, at A then B, 
etc.  
 
Select Next. 
 
 
 
 
 
Step 3: Select the apparatus/interrupter you will be using in the 
experiment.  
 
Select Next. 
 
Step 4: Enter the measurement of the apparatus or interrupter 
required by the calculation.  
 
Select Next.  
 
Step 5: Select the number of decimal places and the units for 
the display of calculated data from the drop-down menus.  
 
Select Next. 
 
Step 6 (Optional): Select to display any additional 
columns of data that were used in the calculation of the 
final set of data.    

 
 
 
 

Note: The option to show these columns are also available from 
Show Columns in the Settings menu.  

 
Select Finish. 

Acceleration at A = Change in Velocity =    Speed A2 – Speed A1  =   

 Time Taken Time A1 to A2 
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LEVEL 2 and 3 choices are: 
 

Measure  
User 
Level 

Interrupter Measurement 

Time  at A 
 

1, 2, 3 
- - 

 from A to B 
 

1, 2, 3 
- - 

 from A to A   
e.g. Stopwatch 

1, 2, 3 
- - 

 at A or B 
 

2, 3 
- - 

 at A then B 
 

2, 3 
- - 

 period at A   
e.g. Pendulum 

2, 3 
- - 

     

Speed / 
Velocity 

at A 
 

1, 2, 3 Single interrupt card - length of card (mm) 

  
 

2, 3 Double interrupt card - segment length (mm) 

  
2, 3 Picket fence 

- fence pitch  (mm) 
- calculation increment (see page 18) 

  
 

2, 3 Pulley - none 

 from A to B 
 

1, 2, 3 - - distance from A to B (m) 

 at A or B 
 

2, 3 Single interrupt card - length of card (mm) 

 at A then B 
 

2, 3 Single interrupt card - length of card (mm) 

     

Distance at A 
2, 3 Picket fence 

- fence pitch (mm)  
- calculation increment (see page 18) 

  
 

2, 3 Pulley          - 

 

Acceleration at A 
 

2, 3 Double interrupt card - segment length (mm) 

  
 Picket fence 

- fence pitch  (mm) 
- calculation increment (see page 18) 

  
 

 Pulley - none 

  at A or B 
 

2, 3 Double interrupt card - segment length (mm) 

 from A to B 
 

2, 3 Single interrupt card - length of card (mm) 

 at A then B 
 

2, 3 Double interrupt card - segment length (mm) 

 change from A to B 
 

2, 3 Double interrupt card - segment length (mm) 

 

Momentum 
and Kinetic 

Energy 

at A 
3 Single interrupt card 

- length of card (mm) 
- mass of object passing through A (kg)  

  
3 Double interrupt card 

- segment length (mm) 
- mass of object passing through A (kg)  

  
3 

Picket fence 
 

- fence pitch (mm) 
- calculation increment (see page18) 
- mass of object passing through A (kg)    

  
 

3 Pulley - mass of object passing through A (kg)          

 at A or B 
3 Single interrupt card 

- length of card (mm) 
- mass of object passing through A (kg) 
- mass of object passing through B (kg) 
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 from A to B 
3  

- distance from A to B (m) 
- mass of object passing through A (kg) 

 at A then A 
3 Single interrupt card 

- length of card  (mm) 
- mass of object passing through A  (kg) 

 change from A to A 
3 Single interrupt card 

- length of card (mm) 
- mass of object passing through A (kg)  

 at A then B 
3 Single interrupt card 

- length of card (mm) 
- mass of object passing through A (kg) 
- mass of object passing through B (kg) 

 change from A to B  
3 Single interrupt card 

- length of card (mm) 
- mass of object passing through A (kg)   
- mass of object passing through B (kg)   

 

Raw Times  
(interrupt edge 

times) 

at A 
 3 - - 

 at A or B 
 

3 - - 

 

Measurements 
 

Measurement at A   
Uses one digital sensor connected to Input 1:A. Timing starts when the signal from Input A changes (ON) 
and stops when the signal reverts back (OFF). 
 

 If Light Gates are used with a single interrupt card, the time measured is for how long the card 
took to pass through the sensor.  

 For a Push Switch it will be the length of time that the switch is kept depressed.  
 For Timing mats it will be the length of time someone stands on the mat.  
 
Measurement from A to A  
E.g. stopwatch. Uses one digital sensor connected to Input 1:A.  
 
Timing will start when the signal at input A changes (ON) and will continue until the 
signal at A goes OFF and then ON again.  
 
Period at A  
E.g. pendulum. Uses one digital sensor connected 
to Input1:A.  
 
Start the pendulum swinging; when it is moving 
freely select the Start icon. 
  
Timing will start when the pendulum first passes 
through the Light Gate. When the pendulum passes 
back through, it will ignore the second signal change 
and will stop at the third change (when the pendulum 
arrives back at the Light Gate). The time shown will 
be for a complete period.  
 
 
 
 

 
Measurement at A then A 
Uses one digital sensor connected to Input 1:A. Time will be measured for a single interrupt card 
passing through a Light Gate (A1), and then returning back through (A2). E.g. for rebound collisions.  
 
Change from A to A 
Uses one digital sensor connected to Input 1:A. The measurement will be for the change in value from A2 
to A1 e.g. for a single interrupt card passing through a Light Gate and returning back through.  

 

Point at which 
the pendulum 
starts and stops 
the recording

Back

Forward

A
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Measurement from A to B 
Uses two sensors connected to Input 1:A and 2:B. A measurement is taken for the time an object takes to 
travel from the sensor at Input A to the sensor at Input B. Timing will start when the signal change at Input 
A is detected  and stops when the signal at Input B changes.  
 
Measurement at A then B 
Uses two sensors connected to Input 1:A and 2:B. Three measurements are recorded of an object 
travelling from the sensor at Input A to the sensor at Input B. The measurements are: 
1. Time to pass through Sensor A 
2. Time to pass through Sensor B 
3. Time to travel from A to B 
 
Measurement at A or B 
Uses two sensors connected to Input 1:A and 2:B. A measurement will be taken from whichever sensor 
detects the change in signal level. The measurement will be the time to pass through either sensor A or 
sensor B. 
 
Change from A to B  
Uses two sensors connected to Input 1:A and 2:B. A double interrupt card is used to measure the 
acceleration at A and then at B. The measurement shown will be the change in acceleration (Acceleration 
at B – Acceleration at A).  
 
Distance at A 
Use the Picket fence or Pulley, with a Light Gate connected to Input 1:A, to measure the distance moved. 
Distance is calculated using the step size of the Data Harvest Pulley, or the pitch length of the Picket 
fence. Each time a new gap in the Pulley or the pitch of the Picket fence is reached; the distance moved 
is known. 
 
Raw Times 
Timing is started when the solid black part of an interrupt 
card blocks the infrared beam on a Light Gate and 
changes the logic level from 0 to 1. When the clear part of 
the card is reached, the infrared beam is restored and its 
logic state changes back to 0 and the event time is taken. 
Raw times show the logic levels as 0 and 1 values with the 
time of the event.   

 

Apparatus 
 

Single Interrupt card 
Measure the solid part of the card that will pass through the Light 
Gate (mm). Speed is calculated using the length of the interrupt 
card divided by the time taken for the card to pass 
 
 
 
 
 
 
Double Interrupt card 
The two segments of a double interrupt card 
must be equal in width. Measure the solid 
part of the card that will pass through the 
Light Gate (mm). 
 
 
 
 

1              0              1              0    

   

 
l 
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Picket fence  
The picket fence is a multi-segmented interrupt 
card so a sequence of measurements will be 
taken.  
 
To improve the accuracy of readings, a 
calculation increment can be applied to 
average the times over fewer pitches.   
 
Note: A calculation increment (of more than 1) will result in fewer measurements than the number of pitches on a fence 
might indicate. 
 

 
 
 
 
 
 
 
 
*Note: If a picket fence with a pitch length of 10 mm is used with buggy type investigations (which produce slower times 
than gravity investigations), the times can be averaged over less pitches so the calculation increment could be reduced to 5.  
 

When a Picket fence is used to measure speed or acceleration, the measurements shown are for 
instantaneous values i.e. it took this amount of time to travel this distance and the acceleration 
was.  
 
 
Spoked Pulley 
The measurements for the Data Harvest Spoked Pulley are pre-defined.  
 
The spokes on the pulley can easily interrupt the Light Gates beam 
to create false results. Wait until all is ready before you select the 
Start icon.  

 
When a Spoked Pulley is used to measure speed or acceleration, 
the measurements shown are for instantaneous values e.g. i.e. at 
this distance, the speed was.  
 
 
 
 
 
 
 

Pitch length (l) Suggested calculation increment 

60 mm or more  1 

50 mm 2 

40 mm 2 

30 mm 3 

20 mm 4 

*10 mm 5 - 8 

E.g. Average acceleration can be measured using a single 
Light Gate with a double interrupt card. Acceleration is 
calculated using the length of the segments on the double 
interrupt card.  
 
 
 
 
 
 
 

 
Acceleration = Change in Velocity  = 
                               Time taken 
  
   V2  Length of segment   - V1  Length of segment    
                  Time                           Time 
 

                              Time taken  

 

 
Measure from the start of one black edge to the start of the next black edge.  

 

 

V2 

V1 

Time taken 
for velocity 
to change 



VISION’s EasySense software  DO234 (3) 
            

Data Harvest Group Ltd.   19 

The Graph window 
 

EasyLog, SnapShot, Graph and Timing use the graph window to display and analyse readings.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Toolbar 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Start or Stop 
 

(Level 1, 2 & 3) 

 

Select this 
icon to return 
to the Home 

page 
 

(Level 1, 2 & 3) 

 
 

Overlay - adds 
a new set of 

data without the 
previous set 
being erased 

 
(Level 1, 2 & 3 

Graph, Snapshot 
and EasyLog) 

 

Interval - find 
the time 
elapsed 

between two 
data points 

 
(Level 1, 2 & 3) 

 

Gradient - 
calculates the 
rate of change 

 
(Level 2 & 3 only) 

 

New - to set 
up a new 

experiment 
 

(Level 1, 2 & 3) 

 

Options - to 
change the 
way data is 
displayed 
 
(Level 1, 2 & 3) 

 

Values - to 
find the value 
at a selected 

point 
 

(Level 1, 2 & 3) 

 

Difference   
between 

the data at 
two points 

 
 (Level 1, 2 & 3) 

 

Area - calculates 
the area under a 

section of the 
graph 

 
(Level 3 only) 

 

 

Notepad – for 
entering 
information 
about an 
experiment 

    

Tap or left click 
below the graph area 
to scroll through any 

X-axis choices 

Data Value  
Boxes 

 

Menu tool bar 

Tool bar 

Left of the graph area:  
Tap or left click 
mouse to scroll 

through channels 
displayed on axis 

 
Tap & hold or right 

click a USB mouse in 
the area to the left of 

the graph area to alter 
the sensor settings 

(name & axis limits) 

For the 
graph menu 
(e.g. Show 
or Hide, 
Channels, 
Zoom, 
Autoscale, 
Predict, 
Add Text 
and Title) 
either tap 
on this 
mouse icon 
or  
tap & hold  
or right click 
a USB 
mouse 
within the 
graph area  

 

Y-axis 

X-axis 

The graph area 

Window divider 

 

    

Double tap or left click mouse above 
the graph area to enter a Title 
 

Tap & hold or right click 
a USB mouse below the 

graph area for X-axis 
options 
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Recording data 
 

To begin recording, simply select the Start icon.  
 
During logging the icon shows a red square. Select this icon to Stop data being recorded before 
the selected duration has passed. 
 
If you want too repeat the last experiment (with all of the settings the same) select the Start icon 
again.  
 
If you want to graph a new set of data, without the previous set of data being erased, select 
Overlay before you select the Start icon. (Not available in Scope or Timing). 
 
 

To set up a new investigation e.g. to change the duration of a recording in Graph, or to identify a 
change of sensors, select the New experiment wizard.  
 
To go from one option to another e.g. from EasyLog to Snapshot, select the Home icon.   

 
 

Selecting Data 
To select individual readings: - 
Tap or click on the reading in the table or on the graph. The reading will be highlighted in the table and 
marked with a cursor on the graph. 
 
To deselect readings:  
Tap or click above the 
graph area.  
 

 
To select more than one reading in a series: - 
Tap (click) and drag from the first to the last reading of the series.  
 

The selected readings will be highlighted in the table and marked by a box in the graph. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Use selection  

To display a selection of the recorded data, select the data required from the table or graph area (so 
it its highlighted). Select Use Selection from the Edit menu and the graph will alter to use the 
selected data only.  
 

If you save while the selected part of the data is displayed, then only the selected data will be saved, 
(not the full data set).  

User Level 2 & 3 
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Selection Wizard  

Selection Wizard from the Edit menu can be used to select readings at 
specified intervals. 
 
Type in the first and last reading of the selection and the interval between the 
readings (e.g. every 10

th
 reading). Select OK and the selected readings will 

be highlighted in the table and graph.   
 
 

 

 

 

 

 

 

 
 
 

If the ‘Use the selection’ box is ticked the graph will automatically alter to 
display only the selected data. 
 

Previous Selection  

Use Previous Selection from the Edit menu to revert back to the previous selection.  

 

Analysing captured data 
There are a number of tools built into the graph window to allow the analysis of captured data. Select 
Analysis from the menu bar to open the Analysis menu. 
 
Note: Some of these tools will not be available when the X-axis is a data channel i.e. Interval, Difference, Gradient 

and Area.   

 
 
 
 
 
 
 
 
 
 

 

 
 
 

User Level 2 & 3 

User Level 2 & 3  

 

 

Analysis menu 

at Users Level 1 

Analysis menu at 

Users Level 2 
Analysis menu at 

Users Level 3 
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Values  

Select Values either using its 
icon or from the Analysis menu.  
 
Tap or click in the graph area. A 
cursor will appear which can be 
moved around the graph. 
 
Position the cursor at the point where 
information from the graph is needed. The 
value will be shown in the data value box 
and highlighted in the table. The 
information box will indicate the time of the 
selected data point.  
 
If the X-axis is a sensor, then cross hair cursor lines indicate what the value from the sensors would be 
if they crossed at the cursor point.  
 
To deselect either tap or click on the arrow         in the information box or deselect Values from the Analysis 
menu. 
 

Interval  

Select Interval either using its 
icon or from the Analysis menu.  
 
Touch and drag from the first point 
to the second point on the graph.  
 
(Drag by keeping the stylus in contact with the screen).  
 

A box will be drawn around the section 
of graph and highlighted in the table.  
 
The information box will display the time of 
the first point, the time at the second point 
and the interval between them.  
 

To deselect either tap or click on the arrow in the information box or deselect Interval from the Analysis menu. 
 
Tap or click in the title area (just above the graph) to deselect any selected readings. 
 

Difference 

Select Difference either using its 
icon or from the Analysis menu.  
 
Tap or click on the first reading 
to be used in the comparison, a 
fixed cursor will mark the point.  
 

Tap or click on a second reading.   
 

The values in the data boxes will show the 
difference between the data at the two points.  
 

While Difference is still selected it is 
possible to repeatedly select a second 
reading to compare with the first.  
 
To deselect either tap or click on the arrow in the information box or deselect Difference from the Analysis menu. 

 

 

 

 

 

 

Difference 
in readings 

1
st
 Point 2

nd
 Point 
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Gradient  

This feature calculates the rate 
of change of data in the vicinity 
of the cursor.  
 
When the graph line is horizontal the 
gradient is zero and values are not 
changing. A positive gradient shows 
that values are increasing – the larger 
the gradient, the faster the change. 
The calculation is performed over two 
points either side of the cursor. 
 

Select Gradient either using its icon or 
from the Analysis menu.  
 
Tap or click in the graph area and a vertical cursor with a small line will appear to indicate the slope of the 
graph for whichever data channel is currently selected on the Y-axis. The gradient value for all data 
channels will be shown in the data value boxes.  
 

To deselect either tap or click on the arrow in the information box or deselect Gradient from the Analysis 
menu. 
 
A manual Best Fit line can be used to calculate the gradient between two points – see page 40.  
 

Area  

This feature is used to 
calculate and display the area 
under a chosen section of the 
graph.  
 

The calculation for area is performed 
on the data from all channels. The 
units correspond to the product of the 
Y and X-axis.   
 

Select Area either using its icon or 
from the Analysis menu.  
 
Touch and drag from the first reading 
point across the appropriate section of 
the graph.  
 
(Drag by keeping the stylus in contact with the screen).  
 

Shading lines will mark the section under the graph for whichever data channel is currently selected on 
the Y-axis. The area value for all data channels will be shown in the data value boxes.   
 

To deselect either tap or click on the arrow in the information box or deselect Area from the Analysis 
menu. 
 
Tap or click in the title area (just above the graph) to deselect any selected readings. 
 

Show Statistics      

Show Statistics calculates and displays statistical information about the data collected from the data 
channel currently selected on the Y-Axis.  
 
Select the appropriate data channel on the Y-Axis. Select Show Statistics from the Analysis menu.  

User Level 3 

User Level 2 & 3 

User Level 2 & 3 
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 Max (Maximum) – the highest value reading  

 Mean – the arithmetic mean. 

 SD (standard deviation) – the scatter of a series of measurements 
about their mean value  

 Min (Minimum) – the lowest value reading 
 

If only a part of the original graph is selected (e.g. by using 
Use selection) then the statistics will be calculated using the 
data from only the selected part of the graph.  
 
To switch statistics off, deselect Show Statistics from the Analysis menu.   

 

Displaying data 

Data Value boxes 

The value recorded by a sensor will be displayed in a data value box. The 
colour used in a data value box corresponds to the colour of the plotted line and 
the axis label on the graph. Each data channel is allocated a different colour i.e. 
channel one is red, channel two is blue, and channel three is green. These 
colours relate to the channel of data, not the type of sensor or the input number 
e.g. if Temperature sensors are used connected to Input 2 and 4 on the 
interface, they will be allocated to the first available data channels, Channel 1 
(red), and Channel 2 (blue).  
 
 

Axis display 

Tap or click in the space to the left of the graph area to alter which data channel is 
displayed. Subsequent taps or clicks will cycle the Y-axis through all the data channels 
open. 
 
Tap & hold      or click with the right mouse button to 
the left of the graph area to open Sensor Settings i.e.   
alter a channels name and minimum or maximum limits 
displayed (see page 26).  

 
 
Tap or click in the space below the graph area to 
cycle through the options available for whatever is 
currently displayed on the X-axis. 
 
1. Time - select between:  

 Elapsed Time - from zero until that point in seconds [Time (s)]. 

 Elapsed Time in days, hours, minutes and seconds [Time (ss), (mm:ss), (hh:mm:ss), 
(d.hh:mm:ss)].  

 Absolute Time - the time & date from the start of recording until that point [Absolute Time 
(hh:mm:ss), (d.hh:mm:ss)]. 

 

2. Sensor - cycle through the data channels available. 
 

3. Reading Number - no choice is available. 
 
Tap & hold      or click with the right mouse button in the space 
below the graph area to open the X-Axis options. Select whether you 
would like Time, Reading Number or Channel (e.g. sensor) displayed 
on the X-axis.  
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Display options  

The options to alter the overall graph display are available 
either from the Display menu bar or the Options icon.  
  
Note: Other display choices, e.g. Show or Hide Channels, 

Zoom, Title and Auto scale, which apply to an individual graph, 
are available by selecting the right mouse icon     (top right of 

the graph area) or by tap & hold       or right click mouse in the 
graph area. See page 27. 

 
 
 

Number of Graphs  
Select the radio button next to the number of graphs that you 
want displayed in the graph area. 

 
 
 
 
 

Graph type  
Use this tab to customise the appearance of the collected data 
in the graph e.g. the graph type, thickness of line and point 
style. 
 
Choose whether you want to display readings as a line or bar 
graph.  
 

 If Line Graph is selected, then individual readings are by 
default joined by a line. There is a choice of different 
thickness of line or no line (none). The readings can be 
marked by a choice of symbols or remain unmarked (none). 

 

 If Bar Graph is selected then readings will be shown as bars of colour. 
 
 

Grid  
If a grid is selected then a faint grid is marked on the graph. 
There is a choice between a fine and coarse grid. 

 
 
 
 
 

 
X-Axis   
Select whether you would like Time, Reading Number or 
Channel (e.g. sensor) displayed on the X-axis  
 

 Time - the selected time span is used for the X-axis.  
 

 Reading Number - the X-axis will be set to the number of 
single readings taken from a sensor, without any regular 
time interval between them. This axis is used for Snapshot 
data. 

 

 Channel  - the X-axis will be set to use one of the data 
channels e.g. a sensor. This axis is used for an X vs.Y plot.   

 
Note: To alter the data channel shown on the X-axis, tap or click with the mouse below the graph area to cycle 

through the data channels. 

 

 

 

 

 

 

User Level 2 & 3 
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Sensor settings 
From this tab the name and limits displayed for a data 
channel or sensor can be altered. 
 
Normally the full scale of a sensor is displayed on an axis 
e.g. the scale for a Temperature sensor will show a 
minimum of -30 to a maximum of 110˚C. If the scale of an 
axis is too large, the minimum and maximum limits 
displayed can be altered e.g. reduced to a minimum of 10 
to a maximum of 50˚C.  
  
The name used for a data channel can also be changed e.g. from 
Temperature to Room Temperature.   
 

 Select the data channel (sensor) you want to edit.  

 Select Edit and type in a new name and/or minimum or maximum 
value number.  

 Select OK. An altered name or number is marked by an asterisk. 
 
To reset to the original name or scale, select the data channel then Reset to Default Name or Reset to 
Default Min_Max. 
 
Display Decimals - used to switch decimal numbers on and off from the display. If Display Decimals is 
not selected, the reading will be rounded up to a whole number.   
 
Select OK to finish.  
 
Notes:  

 If the value from a sensor being recorded rises above the maximum or falls below the minimum limits that have 
been set, Graph will not be able to accurately display the true value. 

 While in Timing, the number of decimal places displayed can be altered - see Change Units on page 33.  

 

Show Table  

The table can be exposed by either: 

  Selecting Show Table from the 
Display menu or  

  Tap or click and hold on the 
window divider (between the data 
value boxes and the graph) until 
it becomes a solid black line and 
drag to the right. 

 

 

 
The sensors/channels columns in the table can be hidden from view.  

 Tap & hold      (or right click with a mouse) in the table area.  

 Deselect the tick next to any sensors/channels you want to hide.  

 

The Comment column 

Once some data has been collected, text or numbers can be entered into the Comment column in the 
table. The comment column is the last column to the right in the table.  
 

 Expose the table area and use horizontal scroll to locate the comment column. 

 Double tap or click on the relevant cell in the comment column. A dialogue box will appear, type in 
any text or numbers. Select OK. 

 

To Edit, double tap or click on the comment to re-open the dialogue box and alter as required.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

 

 

 

Window divider 

The table area 

Data value 
boxes 

 

The graph area 

 



VISION’s EasySense software  DO234 (3) 
            

Data Harvest Group Ltd.   27 

Individual graph choices  
Some display options i.e. Show or Hide Channels, Zoom, Auto scale and Title, are applied on an 
individual graph basis rather than to all graphs displayed. These are available by selecting the right 
mouse icon     (top right of the graph area) or by a tap & hold      (or right click with a mouse) in the 
graph area of the individual graph. 
 

 
 
 
 
 
 
 
 
 

 
 
 

 

Show or Hide Channels 

The data from a channel or sensor can be hidden from view in both the graph and table.  
 
To hide data, select the right mouse icon     or tap & hold      in the 
graph area and select Show or Hide Channels from the menu. 
Deselect the tick next to any sensors or channels you want to hide. 
 

Select    to close.  
 
Reselect the tick to show data. 
 
Example: If two graphs are open, Show or Hide Channels can be 
used to deselect one of the sensors from each graph.  
 
 

Zoom  

An area of the graph can be magnified so that it can be 
seen in greater detail. 
 
Select the right mouse icon     or tap & hold      (or right 
click with a mouse) in the graph area and select Zoom 
In.  
 
Position the mouse pointer at the top corner of the area 
to be magnified. Tap or click, hold down and drag the 
rectangular box over the area to be magnified. Release 
to show the magnified area.   
   
To expand this magnified area further, select Zoom In 
again and repeat the above. 
 
Select the right mouse icon or tap & hold      and select Zoom Out to zoom out by one step or Zoom Off 
to return to the original graph.  
 

 

 

Tool options  
(see page 41) 

 

 

 

 

 

Right mouse icon 
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Auto scale  

This option scales the Y-axis by using the values of the data collected. Select the right mouse icon or 
tap & hold      (or right click with a mouse) in the graph area and select one of four choices from the 
graph menu. The graph will automatically be adjusted.  
 

 Auto scale graph Min_Max – applies Auto scale to all the channels of data on the graph using the 
minimum and maximum limits of the data.   

 Auto scale graph 0 to Max– applies Auto scale to all the channels of data on the graph using a 
minimum value of zero to the maximum limit of the data.  

 Auto scale channel Min_Max – applies Auto scale to whatever data channel is currently selected 
on the Y-axis using the minimum and maximum limits of the data. 

 Auto scale channel 0 to Max - applies Auto scale to whatever data channel is currently selected 
on the Y-axis using a minimum value of zero to the maximum limit of the data.  

 
Deselect to return to the original scale.  
 

Title 

To add a title to a graph:  
 

 Either select the right mouse icon or tap & hold      
in the graph area and select Title or  
double tap above the graph area. 

 

 Type in the text for the title.  
 

Settings 

Overlay mode  

Select the Overlay icon from the toolbar or Overlay Mode from the Settings menu, to add 
a new set of data to the graph without the previous set of data being erased - useful for 
repeating an experiment to compare data.  
 
 

Note: This option is not available in Scope or Timing.  

 

Set Language  

If a choice of language is available then Set Language will be listed in the Settings menu. Use to select 
the language VISION operates with.       
 

Change sensor range 

All Smart Q sensors are automatically calibrated but some have multiple ranges. There are two methods of 
changing the range of a sensor e.g. to alter the range of a Light Level Sensor from Lux to % Transmission. 
 

1. From the New recording wizard   
sensor selection page select the 
sensor’s name and the set range 
window will open. 
 
The range currently selected will be 
highlighted. Select the required range 
and select Finish or Next to continue. 

 
 

 

 

 

Select the 
name to open 
the set sensor 
range window 
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2. Select Sensor Config from the Settings menu. 
 

 Select the sensor from the list (it will be listed 
using its current range). 

 

 Select the Change Range button.  
 
 

The range currently selected will be highlighted. 
 
Note: If no choice is available a message to say ‘This 

Sensor does not have multiple ranges’ will be displayed. 

 

 Select the required range and select OK. 
 

 Close Sensor Config. Select New  and then Finish for 
the change in range to be detected.  

 
The sensor range setting will be retained until changed by the user. 

 

Calibrate Sensor 

All Smart Q Sensors are supplied calibrated. Certain Sensors allow the user to adjust the calibration 
constants to the conditions of the experiment. This option allows the user to adjust the sensor reading at 
either two or three points in its range. The adjustments made will affect the whole Sensor range, 
between and beyond these points. The accuracy of the user calibration will depend upon the number of 
calibration points used and their spacing. 
 
For example: 
The pH Sensor has a default calibration set for operation at a temperature of 25˚C. If the samples 
being measured are at a lower or higher temperature, then this default calibration may be improved by 
a ‘User calibration’. Buffer solutions of a known pH are used to set the values for the calibration points. 
It is essential that the buffer solutions used are at the same temperature as the samples in the 
experiment and that the pH value entered is the value of the buffer at that temperature. For example, a 
buffer solution with a pH of 7.01 at 25˚C can change its value to 7.10 at 5˚C, or 6.98 at 40 ˚C.      
 

 Select Sensor Config from the Settings menu. 
 

 Select the Sensor requiring configuration from the list. 
 

 Select the Calibrate Sensor. 
 

Note: If no choice is available a message to say ‘This sensor does not have User Calibration’ will be displayed. 
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 If you are using 3 test solutions to set the calibration points, 
check the ‘Use Three point calibration’ box is ticked.  

 
If only 2 test solutions are available, deselect the tick in the ‘Use Three point calibration’ box. Only the 
First and Last calibration points will then be available.  
 

 Enter the test solution values of all the buffers that will be used. 
 
 
 
 

 Place the Sensor in the test solution with the lowest value e.g. pH 4 buffer solution. When the 
displayed reading stabilizes, select the Next button & the ADC value will automatically be entered into 
the First value box.  

 

 Place the Sensor in the test solution with the mid range value e.g. pH 7 buffer solution. When the 
displayed reading stabilizes, select the Next button & an ADC value will automatically be entered into 
the Second value box.  

 

 Place the Sensor in the test solution with the highest value e.g. pH 10 buffer solution. When the 
displayed reading stabilizes, select the Next button & an ADC value will automatically be entered into 
the Last value box.  

 

 A message to say ‘The User range has been reprogrammed‘ will be displayed. Select OK.  
 

 Disconnect and reconnect the Sensor from VISION.  
 

 Select Change Range, then User Cal as the range and OK. 

 Close Sensor Config. Select New  for the change in range to be detected.  
 

The User calibration values will be stored in the Smart Q Sensor and will be retained until recalibrated.  
 

The lower section of the Calibrate sensor window displays the current reading from the selected sensor.  
 Default calibration – shows the current value recorded by the default calibration stored in the Sensor. 
 Current User calibration – shows the current value recorded by using the calibration points last configured by 

the user. 
 Raw ADC – shows the value from the analogue digital converter in the EASYSENSE unit in a range of 0 – 

65535. This value is used by the software to calculate the calibration constants. 
 

 

Level 

Select Level from the Settings menu to check or alter the currently 
selected user level.  
 

 Level 1 is aimed at ‘start’ level (e.g. up to 9 years old).  

 Level 2 is aimed at ‘mid’ level (e.g. 9 – 15 years old) 

 Level 3 is aimed at ‘exam’ level (e.g.15 years plus).  
 
Note: The selected level will be saved when the EASYSENSE program is 

closed.  

 

Change Units  

Select Change Units from the Settings menu in Timing to specify the units and 
number of decimal places displayed (0 to 0.000000). Each measurement has its 
own drop-down menu. 
 

 

 

 

Timing only 
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Show Data as   

Data can be recalculated in another form without having to repeat an experiment 
using Show data as from the Settings menu. A Timing Wizard will open, select how 
you want to show the current data and enter any measurements required for the 
calculation. E.g. recalculate Distance data collected using a picket fence to show 
Speed. 
 

Show Columns  

To show the data used to calculate the final 
result select Show Columns from the 
Settings menu in Timing.  
 
Tick the box next to any columns you would 
like displayed from the list. The columns 
available will vary depending on the Timing 
mode selected.  
 
 

System Settings 

Use System Settings from the Settings menu to modify VISION’s settings.  
 
 
 
 
 
 
 
 
 
 
 
      
 
 
 
 
 
 
 

 
Memory Free  
This value indicates the percentage of free memory available for storing user 
data or setup files.  
 

 

Deleting files 
There are two methods of deleting user files (to free more memory).  
 

 Units 

Time ms, s  

Distance mm, cm, m 

Speed/Velocity mm/s, cm/s, m/s, mph, km/h 

Acceleration mm/s
2
, cm/s

2
, m/s

2
 

Momentum g m/s, kg m/s 

Kinetic Energy mJ, J 

 

 

 

Timing only 
 

Timing only 
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TIP: If the inaccuracy of screen taps makes this 
selection difficult use a USB mouse. 

1. From the Memory Free section in System Settings select Delete Files. Select the appropriate data 
file (.ssl) or user setup file (.sss) from the list, and select Delete.  

 

2. Connect VISION to the PC in Disc Drive mode (from the Home screen select Disk Drive from the 
PC Connection menu). VISION will appear as a removable storage device on the PC; use Windows 
Explorer to delete files from VISION’s file storage area. See page 46. 

 
 

Connecting VISION’s VGA port to a projector or monitor  
Ensure VISION is switched on* and connect a USB mouse to the USB host port            on VISION. 
Connect the VGA lead from a projector or monitor to the VGA port          on VISION. The display device 
should automatically be detected by VISION and the display will switch from the LCD display to the VGA 
display device. 
 

* If possible connect VISION to its mains power supply to prevent it automatically going into sleep mode.  

 

If VISION does not detect the VGA device, a manual switch must be made: 
 

 From the Display section in System Settings select Change. VISION will now switch to the VGA 
display device 

 

Note: As a safety measure, VISION will now give you 15 seconds to click on OK to stay on the VGA device; 

otherwise it will automatically switch back to the LCD display. 
 

When you have finished using the VGA display device, either go back into System Settings and click 
change again or switch VISION off and on (it will default back to LCD at power up). 
 
 

Calibrating VISION’s screen 
If screen taps are not accurate recalibrate the screen using VISION’s screen calibration utility.  
 

 From the Calibrate Screen section in 
System Settings select Do it. 

 

 Enter DHG2020 as the password (the password is case 
sensitive, so make sure DHG is in capitals). 

 

 Tap and hold the stylus on the centre of the target for about 4 seconds, when you release the tap the 
target will move (if not tap and hold firmly for longer). 

 

 Repeat as the target moves around the screen (for the four corner positions). 
 

 A message will indicate the new calibration settings have been measured, tap anywhere on the 
screen to save the calibration and exit.   
 
Note: To cancel your attempt wait for 30 seconds without doing anything and the new settings won’t be saved.   

 
 

Time and Date 
 Time: Select any numbers that are not correct and use the left pointer ◄ to reduce its value or the 

right pointer ►to increase its value.   
 

 Date: Select the down pointer ▼to open a calendar. Use the left or right pointers to scroll through the 
months and years and select the correct date. 

 
 

System Reset  
Should VISION fail to respond please attempt a reset, available at two levels:  
 

1. Reset - which will restart VISION – saved data files will be safe but any unsaved data will be lost.  
 

2. Factory Reset – this will reset VISION to its original factory settings. All user memory will be 
cleared this includes all user created data and setup files which will be erased. 

Password = DHG2020 
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 From the Troubleshooting section in System Settings select either Reset or Factory Reset and say 
Yes to the warning message.  

 

 VISON will automatically reset and the start up screen will appear.    
 
 

Update System (VISION’s firmware) 
Occasionally Data Harvest may release updated firmware which will contain improvements or new 
features. Firmware updates and instructions on how to upgrade will be made available on the Data 
Harvest website at www.data-harvest.co.uk/vision and Downloads - Firmware Updates.  
 
 

Logger firmware number  
The firmware version of your VISION unit is displayed in   

1. About from the Help menu or  
2. Logger Information in Sensor Config from the Settings menu.  

 
 

Battery voltage 
Shows an estimate of VISION’s current 
battery voltage level.  
 

Keyboard  

Select Show/Hide Keyboard from the Settings menu to show or hide the keyboard on the screen. 
 
Select Keyboard from the Settings menu can be used to change from the standard size keyboard to a 
larger version (or visa versa). The keyboard will automatically revert to standard size after a reset.  
 
While a USB keyboard is attached to VISION the screen keyboard will not appear.   
 

Using Tools on the data 
Select Tools in the menu bar to open the 
Tools menu. 
 
Note: Some tool options i.e. Predict, Delete 

Predictions and Add Text are applied on an 
individual graph basis rather than to all graphs 
displayed. These are available by selecting the right 
mouse icon (top right of the graph area) or by a tap 

& hold        (or right click with a mouse) in the graph 
area. See page 41. 

 

Smoothing   

Used to ‘even out’ the data of a selected line by applying a 
moving average. 
 
Select Smoothing from the Tools menu. Select the data 
channel that you want to smooth from the drop-down 
menu. Tap or click on the > button to smooth or < to 
reverse the process. The smooth level advances at one 
unit at a time for the > symbol and 5 units for the >> 
symbol. Select OK when the smooth level is correct. 
 

Tools menu at 

Users Level 2 & 3 

 

Tools menu at 

Users Level 1 

 

Between 60 
and 80% 

Between 40 
and 60% 

Between 20 
and 40% 

Between 0 
and 20% 

Between 80 
and 100% 

 

 

http://www.dataharvest.co.uk/products.php?&g=sci&ppg=sci&a=sec&ppa=sec&t=dl&code=2020
http://www.dataharvest.co.uk/downloads.php?type=fa&mlev=15&show=15&title=Firmware%20Updates
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Notes 

Select Notes from the toolbar or 
from the Tools menu to open the 
notes window, which has basic 
text editing facilities.  

 
 
 

The text written in this window is automatically saved in a data file. Use this window to write notes that 
would be useful when setting up the experiment, information about how the data was collected, or your 
conclusions to the experiment.  

 

Test Mode 

Select Test Mode from the Tools menu to test that your sensor is operating correctly. The current 
value from the sensor will appear in its data value box. 
 
The Test option will be active until it is deselected or a recording is started.  
 

Pre-log or Post-log functions  

Functions are mathematical operations that 
can be applied to data.  
 
Note: Pre-log functions are not available in Scope 

or Timing. Post-log functions are not available in 
Timing.   
 

Use a Pre-log function to produce a set of 
data that is created as logging progresses e.g. 
produce both a Distance and Velocity vs. time 
graph from a Motion sensor.  
 

Use a Post-log function to create a set of data 
using data that has already been recorded e.g. 
use Voltage and Current data to calculate Power.  
 
Note: There maybe a slight delay (in most cases unseen) between collection of data and presenting pre-log data on the 

screen e.g. 3 data points are needed before calculation of velocity can commence (acceleration would need 5 points).   

 

 Select whether you want to use a pre-set function or formula.  
 

o Pre-set functions are described in words to make creating the data set simpler.  
o Formula - presents mathematical formula for generating data.  

 
 

Pre-set functions:  
1. Select the subject/topic area from the first 

drop-down list, and then select the 
functions available within this subject 
from the second list.  
 

The panel at the bottom of the window 
gives information about what the function 
will be calculating, what additional 
information will be needed for the 
calculation, units, etc.  

 

Select Next. 
 

User Level 2 & 3 
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2. Select the data channel(s) to be used as 
the source from the drop-down list.  

 
The list of sensors is presented in the order 
of the connected sensor ports. With Post-
log functions the list will include any 
derived data channels. 

    
Select Next. 
 

 
 
3. Details tab: 

Enter the details for the new set of data e.g. 
type in a name and units.  
 
Alter the number of decimal places to be 
displayed if required. 

 
 
 
 
 
 
 
4. Limits tab: 

Select whether the axis limits of this data should 
either expand to fit or use manual limits.  
 
Expand to fit - when the recording has finished, 
the axis will automatically redraw if data has 
exceeded the limits taken from the original 
data.  
 

Manual - use the limits of the axis as specified in the minimum and maximum boxes.  
 

Note: The default value is based on the default limits of the first source channel used in the calculation. If the 

maximum value calculated by the function is less than the source channel limits, apply Autoscale (see page 28) 
to find the limits of the calculated data.    
 
 

5. Parameters tab; 
Enter any parameters required e.g. type in a 
multiplier, constant or scaler.  
 

Numbers can be negative or positive (make sure 
there isn’t a space between the + or – sign and 
the number). 
 

6. Select Finish.  
 

If you are using a Pre-log Function, select the Start icon. Data will be calculated and displayed on the 
graph and table. Values will not be displayed in the data values boxes during logging.  
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Pre-set functions 

SUBJECT  FUNCTION INFORMATION 

Electricity Resistance 
 
 
 
 
 
 

Calculates resistance from Voltage and Current data. Current sensor 
values can be in units of A or mA, Voltage in mV or V. Identify the 
sensor’s units and select the correct multiplier (shown in the white 
information box). For low resistances set decimal places to 3. 
 

When Current is A and Volts is V, make Multiplier = 1  
When Current is A and Volts is mV, make Multiplier = 0.001   
When Current is mA and Volts is V, make Multiplier = 1000  
When Current is mA and Volts is mV, make Multiplier = 1 
 

 Power 
 
 
 
 
 
 

Calculates power from Voltage and Current data. Current sensor values 
can be in units of A or mA, Voltage in mV or V. Identify the sensor units 
and select the correct multiplier (shown in the white information box). 
 

When Current is A and Volts is V, make Multiplier = 1 
When Current is A and Volts is mV, make Multiplier = 0.001 
When Current is mA and Volts is V, make Multiplier = 0.001 
When Current is mA and Volts is mV, make Multiplier = 0.000001 
 

 

SUBJECT  FUNCTION INFORMATION 

Motion Velocity Velocity, calculated from position, distance or displacement data (first 
derivative) as dx where x is the distance data and t is the time data.  
                       dt 
 

Enter the units as appropriate e.g. 
Linear Motion – units (m) – m/s; (cm) – cm/s; (mm) – mm/s; (in) – in/s. 
Pendulum, units (deg) – deg/s.  
 

 Acceleration from 

position data or distance 
data   
 

Acceleration calculated from position or distance data (second 

derivative) as d
2
s or d

2
ϑ. 

                       dt
2
     dt

2
 

 

Enter the units as appropriate e.g. 
Linear Motion – units (m) – m/s/s; (cm) – cm/s/s; (mm) – mm/s/s; (in) – 
in/s/s. 
Pendulum – units; Angular acceleration – deg/s/s.  
- 

 Acceleration from 

Velocity data 
 
 

Acceleration calculated as the first derivative of Velocity data (linear)                                                                                                   
 

Enter the units as appropriate e.g. 
Linear Velocity [m/s] – Linear Acceleration [m/s/s].  
 

 Angular Acceleration 

from Angular Velocity 
data  
 

Angular Acceleration calculated from Angular Velocity (first derivative)  
 

Enter the units as appropriate e.g.  
Angular Velocity (revs/s) – Angular Acceleration, units revs/s/s 
Angular Velocity (rads/s) – Angular Acceleration, units rads/s/s 
- 

 Displacement from a 

reference point 
 
 

 

Displacement = the distance from a reference point.  
The distance value of the reference point is subtracted from the distance 
data to give the displacement.   
 
E.g. with an oscillating spring, the ‘reference point’ would be the distance value of 
the centre of the oscillation. The displacement required is the displacement from 
the centre of oscillation.  
 

 Pendulum - Linear 
Displacement 

Calculates the linear displacement along the arc of the pendulum 
oscillation. It is calculated from the midpoint of the oscillation. 
 
Assumption; the angles are small (less than 20˚) and sinR = R in radians 
 

 Displacement from 

Velocity 
 

Calculates the displacement from Velocity data.  
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Energy Gravitational Potential 
Energy (G.P.E.) 

G.P.E. = Ep = mass (kg) x acceleration due to gravity (m/s/s) x distance (m). 
 

Use to calculate the change in potential energy of an object between two 
points in a gravitational field. 
E.g the GPE gained when a ball bounces to a certain height above the floor. 

Ep = m x g x h 
 

 Kinetic Energy Kinetic Energy = [0.5 x mass (kg)] x velocity
2
 

 
 Pendulum – Potential 

Energy 
Calculates the difference in the potential energy of the pendulum bob 
between the centre of the oscillation and any other position in the 
oscillation. 
 

The angular displacement data must be in radians before this function is 
used (see the Conversion pre-set functions). 
 

 Spring – Elastic 
Potential Energy 

Calculates the change in the elastic potential energy of the spring as a 
result of the displacement of the spring/mass system from the midpoint 
of the oscillation. 
 

Calculated as ½Fx (Joules)  
 

 

General Tare 
 
 

 

Use this function to subtract an offset from a sensor reading (typically 
used to zero the value from a sensor). Find the tare value before using 
this function.  
 

Note: Make the value negative or positive as appropriate e.g. (2) - (2) = 0,  
(-2) - (-2) = 0. 
 

 Asks for Value  

 
(Snapshot Pre-log only) 
 

Each time you tap or click in the graph area to record a value, a dialogue 
box will appear for you to type in a number from the keyboard.  
 

Note: Enter a Name and Units as appropriate. 
 

 Manual Entry Use this function to create a column full of zeros so that your own data 
can be entered via the keyboard.  
 

 Add a constant Use this function to add a number (constant) to each data point. 

 
 Subtract a constant Use this function to subtract a number (constant) from each data point. 

 
 Multiply by a constant Use this function to multiply each data point by a number (constant).  

 

Note: Alter the number of decimal places as appropriate.  
 

 Divide by a constant Use this function to divide each data point by a number (constant). 
 

Note: Alter the number of decimal places as appropriate.  
 

 Moving Average 

(simple) 
 

This is a smoothing function. Each value is the mean of the previous ‘a’ 
number of data points e.g. if a = 5, then the averages of data points 1 to 
5, 2 to 6, 3 to 7, etc. will be taken.  
 

 Mean (x,a) 
 

The sum of all the values in a set of ‘a’ data points divided by ‘a’  
e.g. if a = 5, an mean will be calculated for each set of 5 data points, 1 
to 5, 6 to 10, 11 to 15, etc.  
 

 Average of 2 Channels Adds and divides the data from two Channels to show the average of 
both channels. 
 

Note: Alter the number of decimal places as appropriate. 
  

 Average of 3 Channels Adds and divides the data from three Channels to show the average of 
all three channels. 
 

Note: Alter the number of decimal places as appropriate.  
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Titration Asks for the Volume 

added 
(Snapshot Pre-log only) 
 

This pre-log function will only be available in SnapShot mode. Each time 
you tap or click in the graph area to record a value from the pH Sensor, a 
dialogue box will appear for you to type in a number from your keyboard. 
Enter the TOTAL volume added so far.   
 

 First derivative of pH Creates a sharp peak to identify the point of most rapid change in pH. 

 
 Convert Drops to 

Volume 
 
 

 

Use this function to convert ‘number of drops’ to a volume measurement.  
 

This function needs a value for the volume of one drop. Divide the 
volume in cm

3
 by the number of drops required to fill this volume e.g. 1 

cm
3 
= 27 drops, 1/27 = 0.037 cm

3
 per drop.  

 
Note: Alter the number of decimal places as appropriate.  
 

 

Spirometer Spirometer Air Flow to 
Volume 

This function converts Air Flow data from the Spirometer to Volume. 
 

Volume units = Litres (l) 
 

 Spirometer Volume drift 
correction 
 
(Post-log only) 

 

This function corrects Volume data (which has already been calculated 
from the Air Flow data) for drift.  
 

Note: Volume data must be available to select. The multiplier and constant 
values are pre-calculated.  
 

 

Channel Multiply Channel by 

Channel 
 

This function multiples the data of two Channels together  

 Divide Channel by 

Channel 
 

This function divides the data from one Channel by a second Channel  

 Subtract Channel from 

Channel 
 

This function subtracts the data of one Channel from a second Channel 

 Add two Channels 

together  
 

This function adds the data from two Channels together 
 

 

Oxygen % Saturation to mg/l This function converts Oxygen % saturation data to Oxygen in mg/l.  
 

You will need to supply the Air Pressure (default 101.3 kPa) and the 
Temperature (˚C). 
 

 

Conversion  Convert Degrees 
(angles) to Radians  

Converts Degrees to Radians.   
 

For Pendulum (±20˚) adjust the minimum channel limits to -0.4 and 
maximum channel limits to 0.4.   
 

 Radians to Degrees 
 

Converts Radians to Degrees  

 
 Celsius to Fahrenheit Converts Celsius to Fahrenheit   

 
 Fahrenheit to Celsius 

 

Converts Fahrenheit to Celsius 

 
 Celsius to Kelvin 

 

Converts Celsius to Kelvin  
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Formula functions: 
1. Tap or click on the down arrow to view the formulae available and select from the list. The panel at 

the bottom of the window will give information about what the function will be calculating.  
 

a Mean (x,a) a/(x^b) + c a exp(bt) + c  

ax + by ax
2
 a tx + b a log10(bx) + c  

ax - by a/x
2
 + c a t/x + b a loge(bx) + c 

axy ax
2 
+ bx + c a sin(bx) + c  a log10(bt) + c 

ax/y at
2
 + bt + c a cos(bx) + c a loge(bt) + c  

a/x + c a dy/dx a exp(bx) + c  

(x - a)/b a dx/dt a sin(bt) + c  

Moving average ax
b
 + c a cos(bt) + c  

 

Select Next. 
 

2. Select the data channel(s) to be used as the source of x or y. Tap or click on the arrow to reveal 
the list of sensors connected (presented in the order of the connected sensor ports). With Post-
log functions the list will include any derived data channels.   

 
Select Next. 

 

3. Details tab: Enter the name and units for the new set of data. Alter the number of decimal places 
to be displayed if required. 

 
4. Limits tab: Choose whether the axis limits of this data should either expand to fit or use manual 

limits.  
   

o Expand to fit - when the recording has finished, the axis will automatically redraw if data 
has exceeded the limits taken from the original data.  

 

o Manual - use the limits of the axis as specified in the minimum and maximum boxes.  
 

Note: The default value is based on the default limits of the first source channel used in the calculation. If the 

maximum value calculated by the function is less than the source channel limits, apply Autoscale (see page 
28) to find the limits of the calculated data.    
 

5. Parameters tab: Enter any parameters required e.g. a and b are constants i.e. a number or scaler, c 
is an offset or intercept number. Numbers can be negative or positive (make sure there isn’t a space 
between the + or – sign and the number).  

 
Select Finish.  

 
Notes: 

 A negative number multiplied by a positive number creates a negative. 

 A negative number multiplied by a negative number creates a positive.  

 Any number multiplied by zero = 0. 

 To remove part of a function set the constant’s (a or b) number to zero. E.g. To multiplying a data set by a 
constant would require an ax function. The function ax + by can be altered to ax by setting b to 0 (0 multiplied 
by y = 0).  

 A number multiplied by 1 gives the same number.  

 To leave the value of a data set unchanged by a calculation then the value of a or b should be set as 1. E.g. 
when adding two data sets there is no function x + y but there is ax + by. By setting both a and b to 1 makes 
the function ax +by = 1x +1y = x + y.  

 
If you are using a Pre-log Function, select the Start icon. Data will be calculated and displayed on the 
graph and table. Values will not be displayed in the data values boxes during logging. 
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Best fit  

Select Best Fit from the Tools menu to calculate and produce a straight line which fits most closely 
to the collected data. It can be applied to the whole set of data or to a selected part. 
 
Note: If you want to apply an automatic line of best fit to only a part of the collected data, make your selection before 

choosing Best Fit.  
 

 Select the method of Best Fit 
 
Automatic (computer calculated) - the line will be drawn 
automatically across the entire range of the selected data. 
 
Manual (drawn freehand) - lets you draw the line of best fit 
between any two points 

 

 Select Next. 
 

Manual  

 Select the Axes for the line of Best Fit  
 
Y-Axis – select the data channel/sensor to which you 
want to fit to the line from the drop-down menu. 
 
X-Axis – the current X-axis will be selected by default. 
If the X-axis is Channel, select the data channel to be 
used from the drop-down list. 

 

 Select OK to finish. 

 Tap or click and hold at the start point, drag the ‘rubber band’ line to the end point and tap or click to 
finish.  

 
A manual best fit line can be adjusted. Tap or click on the end point of the line, hold down and 
drag to its new position.  
 
To delete a best fit line, tap & hold      (or right click with a mouse) on the line and select Delete. 

 
Information shown  

Manual: (y = bx + a) 
 
y = the data channel selected 
x = as selected (i.e. time, reading or a data channel) 
a is the intercept  
b is the constant of the slope (gradient between two points) 
 

Automatic  

 Select the Axes for the line of Best Fit  
Y-Axis – select the data channel/sensor to which you want to fit to the line from the drop-down menu. 
X-Axis – the current X-axis will be selected by default. If the X-axis is Channel, select the data 
channel to be used from the drop-down list. 

 

 Select OK to finish or if you currently have data selected but want the best fit line to be applied to 
the whole set of data select Next, No then OK. 

 

 The line will be drawn automatically. 
 

Information shown  
Automatic: (y = bx + a), r

2
 = 

 
y = the data channel selected 
x = as selected (i.e. time, reading or a data channel) 
b is the constant of the slope (gradient between two points) 
a is the intercept  

User Level 2 & 3 

 

 

b = constant a = the intercept 

 

b = constant a = the intercept 
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r
2 

is a fraction between 0 and 1. A high r
2
 tells you the line came very close to the points of data. When r

2
 = 1, 

all points line up exactly on a straight line with no scatter (so knowing x would let you predict y perfectly).  An r
2 

value of 0 means there is no linear relationship between x and y (so knowing x doesn’t not help you predict y).  

 
Note: The r

2
 value is only available if an Automatic line is drawn.  

 

To delete a best fit line, tap & hold      (or right click with a mouse) on the line and select Delete. 
 

Show Calculation  

Use to show how a result has been calculated for a reading in Timing.  
 
Select a reading from the table, and select Show Calculation from the Tools menu. The formula and 
measurements used in the calculation will be shown.  
 
Select Next to see the calculation for the next reading or Cancel to finish.  
 
Note: A calculation will not be available for data collected using a Picket fence or Pulley.  

 
 

Individual graph choices 
Some tool options i.e. Predict, Delete Predictions 
and Add Text are applied on an individual graph 
basis rather than to all graphs displayed. These are 
available by selecting the right mouse icon     (top 
right of the graph area) or by a tap & hold      (or 
right click with a USB mouse) in the graph area of 
the individual graph.  
 
 

Predict 

Used to anticipate the effect of a change to the measured parameter before data is recorded e.g. moving 
a Temperature Sensor from hot to cold water. Predict lines can be drawn on a graph to predict where you 
think the graph line will go.  
 
To make a Prediction: 

 Select the right mouse icon     or tap & hold        
in the graph area and select Predict. 

 

 Tap and drag from the start point and a thick 
black line will appear. Use the line to draw a 
prediction on the graph. Tap or click at different 
points on the graph to fix the line in position.  

 

 Select the right mouse icon or tap & hold and 
deselect Predict. 

 

 Record the data as normal to test the validity of your prediction.    
 
To delete any unwanted prediction lines select the right mouse icon or tap & hold       in the graph area 
and select Delete Prediction. Use the forward and backward buttons to cycle through the prediction 
lines. As each line is selected it will turn red on the graph. Select the Delete button to erase the 
prediction.  
 

Add Text 

Used to annotate the graph with ‘text boxes’ that can be 
placed in any position in the graph area. Each text box 
has a line which can be made to ‘point’ to a part of the 
graph to which it refers.  

 

Timing only 
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 Select the right mouse icon or tap & hold      in the graph area and select Add Text.  
 

 A dialogue box will open. Type in the required text and select OK. (Use the enter key to move text to 
a new line).  
 

 Tap in graph area at the position you want the label to refer to, drag the ‘ghost’ rectangular box that 
appears to the required position for the label. Tap or click and the label will appear. 

 
The label can be moved at any time - tap or click on the label and drag.  
 
To edit or delete a label, tap & hold      on the appropriate label and select Edit or Delete.  

 

Deleting data 

Delete selected  
Select the data that you want to delete – see page 20. Select Delete selected from the Edit menu and 
confirm the deletion of the currently selected data. 
 
If the data is recorded with a constant time interval between readings (Graph and EasyLog), the data will 
be deleted but the time intervals will remain consistent. If readings are displayed as joined by a line, it will 
redraw between the data points.   
 
If data is recorded with an inconsistent time point (Snapshot), both the data and reading number will be 
deleted and the graph will redraw.  

 

Edit a value 

Double tap on the appropriate reading in the table, edit 
the value and select OK.    

 

 
 

Delete Data Sets  

Use Delete Data Set from the Edit menu to erase an entire 
set of data.  
 
Choose the channel of data to erase from the drop down 
menu. Select Erase and confirm the permanent deletion of the 
data set from that channel.  
 

Note: Once a data set has been deleted there is no recover option. 

 

Merging Data  

Select Merge with file from the File menu to merge the current data with a saved .SSL file. The data 
must be recorded with a time base (not suitable for Snapshot data) and the intersample time of the data 
must be the same for both.  
 

Note: You may find it best to set up a recording using a method in which the intersample time for the recording is 

specified e.g.  Graph rather than using EasyLog if you intend to merge the resulting files 
 

This option is not available at User Level 1 & 2 or with SnapShot and Timing. 
 
 

User Level 3  

User Level 2 & 3 
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File options  

Item Available  in Description 

Home Meters, EasyLog, 
Snapshot, Graph, 
Scope, Timing 
 

To return to the Home screen. 

New EasyLog, Snapshot, 
Graph, Scope, 
Timing 
 

Use to set up a new recording e.g. opens a Logging wizard. 
 

Open  EasyLog, Snapshot, 
Graph, Scope, 
Timing 

Use to load a previously saved data file. Locate the EasySense file 
(.SSL) and select OK. 
 
[Default save location is User Files\Data Files].  
 

If you are opening a file saved on a memory stick connect the USB 
memory stick to the USB host port on VISION before selecting 
Open. 
 

Save EasyLog, Snapshot, 
Graph, Scope, 
Timing 

Provided the file has been saved previously, the data will 
automatically be saved, retaining its original name. 
 
Notes: If you Save while only a selected part of the data is being used 

then only the selected data will be saved.   
 

Save As EasyLog, Snapshot, 
Graph, Scope, 
Timing 

A dialogue box will open to allow the captured data to be saved as 
an EasySense file using a filename and destination of your choice. 
Saved as .SSL type. 
 
[Default save location is User Files\Data Files].  

 
If you are saving to a memory stick connect the USB memory stick 
to the USB host port on VISION before selecting Save As.  
 

Note: The Save or Save As options are not available in Meters as the 

data collected is live, but data recorded ‘behind the scenes’ can be 
transferred into the Graph window and then saved.  
 

   If VISION’s battery voltage level drops too low then any data being 
recorded will be saved as an .SSL file called Auto-Saved Data in 
the User Files\Data Files folder.  
 

Save Setup 
 

Meters, EasyLog, 
Snapshot, Graph, 
Scope, Timing 

The settings for an experiment can be saved as a Setup file. This 
allows the use of the same settings at a future date without going 
through the set-up process. 
 
See page 44.  
 

Export as a 
CSV file  
(or .SID file) 

 

EasyLog, Snapshot, 
Graph, Scope, 
Timing   

From the dialogue box select the Type as either SID or CSV and 
enter a file name and destination of your choice.  
 

If you are saving to a memory stick connect the USB memory stick 
to the USB host port on VISION before selecting Export as.  
 
Notes:  

 Files saved in .SID format contain information about units and 
measurements so allow free exchange of data between varieties of 
data logging software systems. 

 Files saved in CSV format (comma-separated values) are in a simple 
text format suitable for database table /spreadsheet systems e.g. 
Microsoft Excel.  
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Setup Files 

To save a Setup file 

 Set up the parameters of an experiment using the appropriate logging option i.e. EasyLog, Meters, 

Snapshot, Graph, Scope or Timing.  

 

E.g.  Select the Users level, recording times, interval between samples, any start conditions or pre-

triggers plus any options required for display i.e. show table, number of graphs, line thickness and 

point style, grid on/off, X-axis, name, minimum and maximum limits, title, predictions, deselected 

channels, pre-log functions, notes, overlay, etc. 
 

 Select Save Setup from the File Menu. 
 

 Type in a suitable name for the experiment - 
this is the name that will be displayed in the 
setup window list. Select OK. 

 
 

 A dialogue box will open. Type in the file 
name. Select OK. 

  
Note: The file is saved to the User Files\Setup 

Files folder.  

 
 
 
 

 

To open a Setup file 

From the Home screen select Open Setup from the File menu to open the software pre-configured for an 
investigation. 

 

To open one of the setups supplied with 

VISION: 
 

1. Open the Data Harvest Investigations 

directory. 
 

2. Open the folder for the appropriate 

setup files e.g. 5 Minute Activities. 
 

3. Locate the investigation and double tap 

or click on its setup file. One of the 

logging options e.g. Graph, will open 

pre-set to record this investigation. 

 

Tap and drag the window divider to reveal a larger area of the list.  

 

To open one of your own set ups:  
 

1. Open the My Investigations folder. 
 

2. Locate the investigation and double 

tap or click on its setup file.  

 

 

 

 

 

 

 

Window 
divider 
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Screen capture 

Graph and Table area 

This method will capture and save whatever is shown in the graph and/or table area in EasyLog, Graph, 
Scope, SnapShot and Timing as a bitmap image for use in your report document. 
 

 Ensure the graph and/or table that you wish to save is displayed on VISION’s screen.  

 Select Export Screen from the File menu.  

 Enter a file name for the bitmap image and OK. 

 Connect VISION to your PC computer as a Disc Drive (select Disc Drive from PC Connection on the 
Home screen). The bitmap images will be available in the Data Files directory. 

  

Full screen capture  

This method will capture a snapshot of the entire VISION screen, including any drop-down menus, etc. 
 

 Plug a USB keyboard into the USB host port            on VISION.  

 Ensure what you wish to capture is displayed on VISION’s screen. 

 On the keyboard press the print screen button. 

 Connect VISION to your PC computer as a Disc Drive (select Disc 
Drive from PC Connection on the Home screen). The bitmap 
images will available from a Screen Shots directory within Data 
Files using an incremental filename. 

 

Printing 
VISION will print to most Hewlett Packard PCL compatible printers in either a portrait or landscape 
format, back and white or in colour*.   
 
Connect a compatible printer to the USB host port            on VISION (printer turned on).  
 

Print Meters only 
  

To print out a copy of the current screen display.  
  

Print Graph EasyLog, Snapshot, 
Graph, Scope, 
Timing 

To print out a copy of the current graph.   
 

Print Table EasyLog, Snapshot, 
Graph, Scope, 
Timing 

To print out a copy of the current table. Be aware that a table can 
use multiple pages to print. 
 

 
*VISION will only print greyscale with a HP Colour LaserJet printer (not in colour).  

 

Apps 
Select Apps either from the Home screen or File menu to open or manage additional applications that 
have been installed on VISION e.g. the Periodic Table, Scientific Calculator. 
 
To install a new App 

 Download and Save the compressed application from our website to your PC computer. ‘Unzip’ to 
extract the applications folder to the top level of a USB memory stick. 

 Connect the USB memory stick to the USB host port             on VISION. 

 Select Apps either from the Home screen or File menu. 

 Select Install/Update from the Settings menu. 

 Select the application to install from the list and OK.  
 
To uninstall an App 

 Select Apps either from the Home screen or File menu. 
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 Select the application you want to remove. 

 Select Remove from the Settings menu. 

 Enter DHG2020 as the password (the password is case 
sensitive, so make sure DHG is in capitals) and OK. 

  

 

Transferring files between VISION and a PC computer  
Saved data files can either be transferred from VISION to your PC by using VISION in ‘disc drive’ mode 
or can be opened direct into the EasySense PC software by using the Retrieve Remote function while 
VISION is connected as an interface. 
 
Saved setup or bitmap files can be transferred from VISION to your PC or visa versa by using VISION in 
‘disc drive’ mode. 
 

 Save any data you have on screen. 

 Connect VISION to the PC using the USB cable supplied.  
 

Using VISION in Disc Drive mode  

 From the Home screen select Disk Drive from the PC Connection menu. 
 
VISION’s screen will alter to show its USB connected.  
 
 

 The first time VISION is connected allow the USB device drivers to 
install. VISION will appear as a removable storage device on the PC (no 
special drivers are required).  

 
Windows Explorer can be used to drag and drop files between VISION 
and your PC (maximum file size for VISION is 5 MB). 
 

 When you’ve finished tell Windows that you are about to remove the 
device e.g. using the Safely Remove Hardware icon from the computer’s 
taskbar and once safe to do so disconnect VISION from the USB port. 
VISION’s EasySense software will automatically restart.  

 

Retrieving data files with VISION connected as an Interface 

 From VISION’s Home screen select the Interface button. 
 

VISION’s screen will alter to show its 
USB connected.  

 
 Open the EasySense software on your PC computer.   
 

 Select Retrieve Remote from the Home screen. 
 

 Select the data file from the list then Retrieve.  
 
When you’ve finished using VISION as an interface, disconnect from the USB port and VISION’s 
EasySense software will automatically restart.  

Password = DHG2020 
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Using VISION as in interface (controlled by the EasySense software 
on a PC computer)   

 Save any data you have on screen. 

 Connect VISION to the PC using the USB cable supplied. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Select Interface either from VISION’s Home screen or from the PC Connection menu.  
 
VISION’s screen will alter to show its USB connected*.  
 
 

 The first time VISION is connected allow the USB device drivers to install. 
 

 Open the EasySense software on your PC computer e.g. Start ► Programs ► Data 
Harvest ► and double click on EasySense Software.  Select an experimental mode from 
the Home screen i.e. EasyLog, Graph, Meters, Scope, SnapShot or Timing.  

 

When you’ve finished using VISION as an interface, disconnect VISION from the USB port and VISION 
will restart.  
 
* If VISION does not find a connection with the PC within 10 seconds, it will automatically restart VISION’s 
EasySense software. 
 

Help - About 
Contains information about the version number of the EasySense software and VISION’s build and PIC 
firmware version number.  
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Duration and Interval Table for Logging   
 Pre-triggers are only available with fast recording times and when a trigger has been set. 

 For very fast sample rates there is a limit to the number of sensors that can be connected, this is indicated 
in the maximum sensors column.   

 The following Smart Q Sensors are not able to provide readings at intervals of less than 20 ms (50 Hz): 
Ohaus Scout Pro Top-pan Balance Adapter (Product No. 3060), Carbon Dioxide Gas Sensor (Product No. 
3152), Drop Counter and Bubble Sensor (Product No. 3266), Geiger Muller Sensor (Product No. 3265), the 
beats per minute range of the Heart Rate and Pulse Waveform Sensor (Product No. 3147), Motion Sensor 
(Product No.3705 or 3270) and the Polar Heart Rate Exercise Sensor (Product No. 3148).  

 
 

Graph 
 

Duration Interval Samples 
Max. no. of 

sensors 
Pre-trigger  Duration Interval Samples 

Max. no. of 
sensors 

Pre-trigger 

20 ms 20 µs 1000 1   25 ms 20 µs 1250 1 

(0.02 s) 25 µs 800 1   (0.025 s)  25 µs 1000 1 

 50 µs 400 1    50 µs 500 1 

 100 µs 200 1    100 µs 250 1 

 200 µs 100 1    200 µs 125 1 

 500 µs 40 1    500 µs 50 1 

 1 ms 20 1    1 ms 25 1 

 2 ms 10 1    2 ms 12 1 

 
 

Duration Interval Samples 
Max. no. of 

sensors 
Pre-trigger  Duration Interval Samples 

Max. no. of 
sensors 

Pre-trigger 

50 ms 20 µs 2500 1   100 ms 25 µs 4000 1 

(0.05 s) 25 µs 1000 1   (0.1 s) 50 µs 2000 2 

 50 µs 1000 2    100 µs 1000 4 

 100 µs 500 2    200 µs 500 4 

 200 µs 250 2    500 µs 200 4 

 500 µs 100 2    1 ms 100 4 

 1 ms 50 2    2 ms 50 4 

 2 ms 25 2    5 ms 20 4 

 5 ms 10 2    10 ms 10 4 

 
 

Duration Interval Samples 
Max. no. of 

sensors 
Pre-trigger  Duration Interval Samples 

Max. no. of 
sensors 

Pre-trigger 

200 ms 50 µs 4000 2   500 ms 200 µs 2500 4 

(0.2 s) 100 µs 2000 4   (0.5 s) 500 µs 1000 4 

 200 µs 1000 4    1 ms 500 4 

 500 µs 400 4    2 ms 250 4 

 1 ms 200 4    5 ms 100 4 

 2 ms 100 4    10 ms 50 4 

 5 ms 40 4    20 ms 25 4 

 10 ms 20 4    25 ms 20 4 

 20 ms 10 4    50 ms 10 4 
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Duration Interval Samples 
Pre-

trigger 
 

Duration Interval Samples 
Pre-

trigger 
 

Duration Interval Samples 
Pre-

trigger 

1 s 500 µs 2000   2 s 500 µs 4000   5 s 2 ms 2500 

 1 ms 1000    1 ms 2000    5 ms 1000 

 2 ms 500    2 ms 1000    10 ms 500 

 5 ms 200    5 ms 400    20 ms 250 

 10 ms 100    10 ms 200    25 ms 200 

 20 ms 50    20 ms 100    50 ms 100 

 25 ms 40    25 ms 80    100 ms 50 

 50 ms 20    50 ms 40    200 ms 25 

 100 ms 10    100 ms 20    500 ms 10 

      200 ms 10      

 
 

Duration Interval Samples 
Pre-

trigger 
 

Duration Interval Samples 
Pre-

trigger 
 

Duration Interval Samples 
Pre-

trigger 

10 s 5 ms 2000   20 s 5 ms 4000   30 s 10 ms 3000 

 10 ms 1000    10 ms 2000    20 ms 1500 

 20 ms 500    20 ms 1000    25 ms 1200 

 25 ms 400    25 ms 800    50 ms 600 

 50 ms 200    50 ms 400    100 ms 300  

 100 ms 100    100 ms 200    200 ms 150  

 200 ms 50    200 ms 100    500 ms 60  

 500 ms 20    500 ms 40    1 s 30  

 1 s 10    1 s 20 
 2 s 15  

      2 s 10 
   

 
 

Duration Interval Samples 
 

Duration Interval Samples 
 

Duration Interval Samples 

1 min 20 ms 3000  2 min 50 ms 2400  5 min 100 ms 3000 

 25 ms 2400   100 ms 1200   200 ms 1500 

 50 ms 1200   200 ms 600   500 ms 600 

 100 ms 600   500 ms 240   1 s 300 

 200 ms 300   1 s 120   2 s 150 

 500 ms 120   2 s 60   5 s 60 

 1 s 60   5 s 24   10 s 30 

 2 s 30   10 s 12   20 s 15 

 5 s 12       30 s 10 

 
 

Duration Interval Samples 
 

Duration Interval Samples 
 

Duration Interval Samples 

10 min 200 ms 3000  20 min 500 ms 2400  30 min 500 ms 3600 

 500 ms 1200   1 s 1200   1 s 1800 

 1 s 600   2 s 600   2 s 900 

 2 s 300   5 s 240   5 s 360 

 5 s 120   10 s 120   10 s 180 

 10 s 60   20 s 60   
20 s 90 

 20 s 30   30 s 40   30 s 60 

 30 s 20   1 min 20   1 min 30 

 1 min 10   2 min 10   2 min 15 
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Duration Interval Samples 
 

Duration Interval Samples  Duration Interval Samples 
 

Duration Interval Samples 

1 hour 1 s 3600  2 hours 2 s 3600  3 hours 5 s 2160  4 hours 5 s 2880 

 2 s 1800   5 s 1440   10 s 1080   10 s 1440 

 5 s 720   10 s 720   20 s 540   20 s 720 

 10 s 360   20 s 360   30 s 360   30 s 480 

 20 s 180   30 s 240   1 min 180   1 min 240 

 30 s 120   1 min 120   2 min 90   2 min 120 

 1 min 60   2 min 60   5 min 36   5 min 48 

 2 min 30   5 min 24   10 min 18   10 min 24 

 5 min 12   10 min 12       20 min 12 

 
 

Duration Interval Samples 
 

Duration Interval Samples 
 

Duration Interval Samples  Duration Interval Samples 

5 hours 5 s 3600  6 hours 10 s 2160  7 hours 10 s 2520  8 hours 10 s 2880 

 10 s 1800   20 s 1080   20 s 1260   20 s 1440 

 20 s 900   30 s 720   30 s 840   30 s 960 

 30 s 600   1 min 360   1 min 420   1 min 480 

 1 min 300   2 min 180   2 min 210   2 min 240 

 2 min 150   5 min 72   5 min 84   5 min 96 

 5 min 60   10 min 36   10 min 42   10 min 48 

 10 min 30   20 min 18   20 min 21   20 min 24 

 20 min 15   30 min 12   30 min 14   30 min 16 

  30 min 10             

 
 

Duration Interval Samples 
 

Duration Interval Samples 
 

Duration Interval Samples 
 

Duration Interval Samples 

12 hrs 20 s 2160  1 day 30 s 2880  2 days 1 min 2880  3 days 2 min 2160 

 30 s 1440   1 min 1440   2 min 1440   5 min 864 

 1 min 720   2 min 720   5 min 576   10 min 432 

 2 min 360   5 min 288   10 min 288   20 min 216 

 5 min 144   10 min 144   20 min 144   30 min 144 

 10 min 72   20 min 72   30 min 96   1 hour 72 

 20 min 36   30 min 48   1 hour 48     

 30 min 24   1 hour 24         

 1 hour 12             

 
 

Duration Interval Samples 
 

Duration Interval Samples  Duration Interval Samples 
 

Duration Interval Samples 

4 days 2 min 2880  5 days 2 min 3600  6 days 5 min 1728  7 days 5 min 2016 

 5 min 1152   5 min 1440   10 min 864   10 min 1008 

 10 min 576   10 min 720   20 min 432   20 min 504 

 20 min 288   20 min 360   30 min 288   30 min 336 

 30 min 192   30 min 240   1 hour 144   1 hour 168 

 1 hour 96   1 hour 120         
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Duration Interval Samples 
 

Duration Interval Samples 
 

Duration Interval Samples 
 

Duration Interval Samples 

10 days 5 min 2880  14 days 10 min 2016  21 days 10 min 3024  28 days 20 min 2016 

 10 min 1440   20 min 1008   20 min 1512   30 min 1344 

 20 min 720   30 min 672   30 min 1008   1 hour 672 

 30 min 480   1 hour 336   1 hour 504     

 1 hour 240             

 
 

Duration Interval Samples 

35 days 20 min 2520 

 30 min 1680 

 1 hour 840 

 
 
 

Scope 

Duration 5.12 ms 12.8 ms 25.6 ms 51.2 ms 128 ms 256 ms 512 ms 1.28 s 2.56 s 

Interval 20 s 50 s 100 s 200 s 500 s 1 ms 2 ms 5 ms 10 ms 

Max. no. of sensors 1 2 4 4 4 4 4 4 4 

 

Duration Roll mode Roll mode Roll mode Roll mode Roll mode 

Interval 20 ms 50 ms 100 ms 200 ms 500 ms 

Max. no. of sensors 4 4 4 4 4 
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Interval .................................................................... 22 
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Line of best fit ......................................................... 40 

Linear displacement function .................................. 36 
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EASYSENSE Software Multi-user Site Licence 

 
Definitions 

The following expressions have the meanings given here: 

 

 ‘DHG’ means Data Harvest Group Limited, being owner of all intellectual 

property rights in the Software 
 

 ‘Documentation’ means both printed and electronic user documentation. 

 

 ‘Software’ means the program supplied. 

 

Licence 

This software package may be freely used, copied, and disseminated. This 

includes any associated documentation and user guides.  

 

The software may not be amended, changed or altered in anyway.   

 

Limited Warranty and Disclaimer of Liability 

The Software is supplied ‘as is’; DHG makes no warranty, whether express 

or implied, as to the merchant ability of the Software or its fitness for any 

particular purpose. In no circumstances will DHG be liable for any 

damage, loss of profits, goodwill or for any indirect or consequential loss 

arising out of your use of the Software, or inability to use the Software, 

even if DHG has been advised of the possibility of such loss. 

 

 

General 

These conditions supersede any prior agreement, oral or written, between 

the licensee and DHG relating to the software. 

 
 

 


